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Word Processing using Microsoft Works 2

Lesson 1
Text entry and editing.

Run Microsoft Works by double  clicking on  it’s icon.
MS Works Icon

When Works is run the Open File dialog appears.  This allows you to
select an existing file to edit.

The Create New Document dialog appears.
This allows you to select one of  four types of document.  At the moment
we want a WP document which is already selected, so just click OK.
A new blank WP document appears with the insertion point  as a flashing
vertical line at the top left of the screen.
Type your full name on the top of the screen.  Press the return key twice
to leave two blank lines.

A few points
There is no need to press return at the ends of lines, the machine will take
care of new lines for you.  Pressing return is only needed at the ends of
paragraphs and short title lines.
Leave a single space between words and after punctuation marks except
full stops.  Leave two spaces after a full stop.
Do not indent the first line of a paragraph by inserting spaces.

Text entry

However we want to start a new file, here's how it is done.
Using the mouse, move the pointer to the word File on the menubar. Click
the mouse button and hold it down.  Still holding the button drag down to
the word New and let go.
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Type the following piece of text remembering to hold down the shift key
for capital letters,  and to leave two spaces after a fullstop.
Do not worry  about errors for the moment they can be corrected later.

Good presentation is central to any design work.  This
applies not just to manufactured items but to draw-
ings, records and written reports.  Drawings should be
presented to be attractive to the viewer.  While accu-
rate diagrams will attract the eye, poor layout will take
away from them.  Any final drawing should be laid out
with a border around the edge of the paper.  Included
on the page should be the title of the drawing, the
student’s name and the date.  Later on the scale, and
the type of projection should be included.

Correcting errors
Read back over what you have just typed and look for errors.
If you spot an error, use the mouse to move the screen pointer to the
character to the right of the error.
Click the mouse button to position the insertion point.
Press the delete key to remove the offending characters.
Type in the correct text.   The following text will move out of the way to
make room for what you type.
Move on to the next error.

Saving your work
Move the mouse pointer to the word File on the Menu Bar.
Click the button.— A menu appears.
Continuing to hold the button drag the mouse down to the words Save as...
and let go. — A dialogue box appears.
Type your initials followed by the number one as a file name.
E.G. John Murphy would type JM1.
Do not use spaces or punctuation marks in file names.
Click on the word Save in the dialogue box.

Quiting from Works.
Click on the word File in the Menu Bar.
Drag the mouse down until Quit is highlighted let go of the button.
If the message “Save  changes to JM1” appears click on Yes.

Lesson 2

Save as... dialogue box.
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Opening files and more editing.
Double click on the Works icon to start the application.
The Open File dialog appears.
Select your file from the list by clicking on it's name and then click Open.
If you cannot see the name of your file, use the scroll bars at the side of the
list, to scroll down the list to your file.
After a short delay your file should appear on screen.

Inserting a title
Use the mouse to position the insertion point before the word Good at the
start of your file.
Type in the title Presentation and press return.  —The text will move out
of the way to make space for the title.

More Text
Move the insertion point to the end of the paragraph press return to leave
a blank line.
Then type the following:

Records:
It is important for the student to keep written
records of her/his work in all areas of the course.
This will help with later evaluation and provide
ideas for other projects later on.  Standard
record sheets are a useful way of keeping rec-
ords.  The difficulty with  this is finding a general
sheet that will be suitable in different areas of the
course.  It may be that a number of different
sheets will be necessary.

Check the above text for errors and correct them as before.
Save the file .
Quit from Works.

Lesson 3
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Adding more text and printing.

Run Microsoft Works and  open the file used in lesson 2.
If you can’t remember how, look at the start of lesson 2.

Move the insertion point to the end of the second paragraph and press
return twice to leave a blank line.
Then type the following.  This time press return at the end of each line so
that each point occupies a separate line.

Tasks:
Design a page layout for use with future drawings.
Design a report sheet for use with projects.
Design a cover for your class folder.
Design and make a folder to hold your class notes.
Design a cover for a book titled "Technology."
Design a cover for a book titled "Crafts."
Design a cover for the magazine "Practical House-
holder"

Read the new additions you have made to the document and correct any
errors.
Save the changes to your document.

Printing the document.
When you are satisfied that the document is free of errors, it is time to print
it.
First check that you are connected to the printer by doing the following:
Click on the Œ symbol in the menu bar.
Drag down to Chooser on the menu.
Click on QMS-PS 410 to select the LaserWriter as the printer.
Click on the Close  box to get rid of the dialogue box.

Send the document to the printer:
Click on File to select the file menu.

Chooser dialogue box.

Close box

Drag down to Print  and release.
A dialogue box appears.  No changes should be necessary so click Print.
After a short delay your document will print at the printer.

Save your work.
Quit from Works.

Lesson 4
Moving Text.
Cut and Paste

Print dialogue box.
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On proof reading it appears that the paragraph headed Tasks should be
placed before the one titled Records.  This is how to move them without
re-typing the lot.
Select the paragraph starting with Tasks by clicking with the mouse before
the T of tasks and dragging down to include the full paragraph.
Click on Edit on the menu bar.
Drag down to Cut and release the mouse button.
Move the insertion point to before the R of Records.
Click on Edit on the menu bar.
Drag down to Paste and release the mouse button.
The Tasks paragraph will be inserted before the Records paragraph.

Save and Print this version of you document.

Exercises
Make the Presentation paragraph the last paragraph.
Re-arrange the document to the same way it was at the start.

Copy and Paste.
Sometimes you may want two copies of the one piece of text  in a
document.  Copy and Paste is used to do this.

Select your name from the top of the document.
Click on Edit on the menu bar.
Drag down to Copy and release the mouse button.
Move the insertion point to the bottom of the document.
Click on Edit on the menu bar.
Drag down to Paste and release the mouse button.
You name is still at the top of the document and it is now also at the bottom.

Exercise
Delete your name from the bottom using cut.
Save and print this version of the document.

Lesson 5
Formatting

Formatting commands fall into three  main groups.
Character formats, e.g. Italics, bold underline,fonts.
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Paragraph formats, e.g. centred, justified, right aligned, indents, tabs, line
spacing.
Document formats, e.g. margins, page numbering,

Formats are applied by selecting the piece of text first by highlighting and
selecting the command from the Format menu.

Open the document you were using in the last session.
If you can not remember how look up Lesson 2.

Character formats
Changing font size, putting text into italics and bold type.

Select you name at the top of the document by positioning the mouse
pointer before your name, click and hold the button down, drag the pointer
across the name.
To change the font size click on the word Format on the menu bar, the
menu pops down,  drag down to size, another menu pops out,drag down
to 14 point and release — your name will increase in size.
To put your name into italics, make sure the name is still selected, Click on
Format on the menu bar— a menu pops down.
Drag down to Styl, a menu pops out.
Click on Italics  and let go.

Exercise
Put the titles Presentation, Records and Tasks into 18 point bold by the
same method as above.

Paragraph formats
Paragraph formatting can be achieved by using the Justification and
Spacing option from the Format menu.

Centring the heading Presentation.
Select the heading Presentation, click Format, Justification, Center.

Exercise
Centre the other headings also.
Justify the body text.
Double line space the first paragraph
Select the paragraph, select Format, Spacing 11¦2

Exercise:
Change the spacing of the entire document to 11¦2  line space.

Changing Margins.

Format menu.
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For document formatting there is no need to select text.
Select the File menu.
Select Page Setup.
Set margins of two inches top, bottom right and left.
An A4 page is 8.27 inches wide, with margins of 2 inches each side the
maximum text width is therefore 4.27in (8.27-4=4.27 inches).  So you
must make sure that your text is not wider than this.  If it is highlight the entire
document. Then move the small black triangle on the right of the ruler in to
4.27.

Save your document and Print it.

Exercise:
Type up the following piece of text.
Then format it to match the example.

Junior Technology
 Communications Notes

Preface
Aims of the course
a) In deciding how to approach the teaching of the graphics section of the
Junior Technology course it is useful to look at the aims and objectives
of the course and at the syllabus.  The aims of the course can be found in
the syllabus so I will not repeat them here in full.  However they could
perhaps be summarised by:
 The course is intended to awaken an interest in the pupil and to give her/
him the skills to solve practical problems.  In particular  in  relation to
graphics she/he needs to develop the skills of visualisation required in
making artifacts and she/he needs to develop a knowledge of communi-
cations conventions.

Start a new document and type this up.
Tuscany High School

Tuscany

Set margins of two inches al
around.
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Italy
23 February 1991

Chief Inspector,
Department of Education,

Dear Inspector,
I am sick and tired of being a big fish in a small pond.  When are you going
to realise my true potential and get me out of this rathole and into a job with
more bite.  As you know I have already broached the subject of the schools
marketing with you.  Why can't we get out of education and into something
more interesting.
If we have to stay in education how about brightening up some of our
subject titles.  Consider these:

"Basic Electricity and Lighting"
with instructor Seán D'Olier.
"Firearms and Ammunition"

with Rick O'Shea.
"Sheep husbandry"
with Larry Lamb.

You owe it to youself and the department to let me let my creativityroam,
Yours sincerely,
________________
Ima Brain (Principal)

Start a new document and type up the following:
Hilton Hotel

Menu

Soup of the Day

Boef Bourguinon
Ham and Chicken

Strawberries and Cream
Apple Pie and Cream

Tea of Coffee.

10% service charge.
Prices include VAT at 10%

Lesson 6
More Formatting

Tabs

Short cuts:
Many commands can be
performrd quicker using
keyboard shortcuts:
⎟+�  C   for centre
⎟+�  J to justify
⎟+�  L to left align
⎟+�  R to right align
⎟+�  B for bold type
⎟+�  I for italics
where ⎟+�  stands for hold
the shift key and the
command key together
and type the letter.

1 1¦2 line space this paragraph.

Double line space this part

Modify the layout to improve
the appearence of the printed

document.
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Tabs are usually one of the more difficult aspects of formatting.  MS Works
makes the task of setting tabs easier than most word processors.  When
Works starts tabs are preset to positions of 0.5 inches.  These do not suit
most purposes and so they must be changed.  There are two approaches
to seting tabs, one, is to key up the text with the default settings and then
reset the tabs to suit.  The second is to set up the tabs first and then key in
the text.  I prefer the first method and that is what we use here.

Type up the following table pressing tab after each entry and return at the
end of a line.  While you are typing, your text will look like a mess!!!  Dont
worry about this it will all sort itself out later.

Chapter 1 Getting started 1
Chapter 2 Installing the hardware 7
Chapter 3 Preparing disks 15
Chapter 4 Installing the software 19
Chapter 5 Testing the software 21

As typed the first tab position for the chapter titles looks OK but the page
numbers are all wrong.  Lets sort them out.

Switch on the ruler
Select Format  ShowRuler.
Select the piece of text.

Decide where the tabs for the chapter titles should be in inches. Say  2
inches.
Click in the  paragraph setting bar directly below the 2 inch marker. - The
text jumps into line.
Decide where the tab for the page numbers should be in inches. Say  5
inches.

Click in the  paragraph setting bar directly below the 5 inch marker. - The
text jumps into line.

If you are not completly happy with the positions, you can drag the tab
marker across the paragraph settings bar to a new position.

Look at the page numbers, they do not look quite right.  Normally the tens
should be under the tens and the units under the units.  Dont dare use spaces
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to align them!!!!!!    A right aligned tab will sort it out.

Changing tab type.
With the text still highlighted, click on the 5" tab and watch the alignment
change from left to right, and then to decimal and to centered.

More TABS
Type up the following text pressing the tab key at suitable places.

Name Code Quantity Description Price
Malone Ltd C 20 Oranges £160.45
Carr Veg D 5 Apples £98.50
City Fruit & Veg F 100 Satsumas £145
AllFruit B 2 Pears £9
This should look quite a mess now.  Before proceeding decide the
approximate positions and type of tabs required.
Names do not need a tab, they will line up at the left of the page.
For Code, a centered tab at about 1.5 inches might suit.
For Quantity, a right aligned tab will line up the numbers correctly, at about
2inches??
For Description, a left aligned tab will line up the text, you decide on the
position.
For Price, a decimal tab will line up the decimal points.

Lesson 7
More Exercises

Start a new document by selecting File, New...
Type up the following piece of text.  Do not start formatiing until after typing.

MARINO  COMPUTER  PRODUCTS  LIMITED
The Green, Marino, Dublin 9.

Telephone: 303456

Fax:303333

ANTI-STATIC MATS

Are you aware of the importance of protecting your computer
and other visual display units against static electricity?  Do
you know that a build-up of static electricity in or near your
equipment can cause problems in your word processing
terminals and computer equipment?

Marino Computer Products have the answer. You can now
protect your equipment with a spray can of Marino Anti-
static Spray.  Our environmentally friendly  Anti-Static Spray
will cost you only £1.50 a can.  Our bargain pack of six cans
costs £7.00!!!
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Marino Anti-Static mats provide a first line of defence by
reducing the static build up near your computer often caused
by synthetic fibres rubbing against desks.

To  get a copy of our free full-colour brochure of office
supplies,  just complete the enclosed reply-paid card and post
it to Marino Computer Products Limited or simply telephone
our Supplies Department on Dublin 303456. or Fax us at
303333.

After typing Save as...  Anti-Static
Change the character and paragraph formats as shown above.i.e bold
italics, centered justified etc.
Save the file and Print it.
Insert the following piece of text between paragraphs three and four.

Our anti-static products received a high recomendation from
PC Magazine:
The Marino Anti-Static Mat has to be one of the most effective
anti-static products on the market today.  It’s price at £5.95
also makes it the best value.  It's capacity  to reduce static in
the normal office environment is greater than that of products
costing twice the price.

PC- Magazine December 1990.  Best Value Awards.
Save this version of the document and print it.
Remove the paragraph break between paragraph two and three, that is
make paragraph three continuous with paragraph two.
Make a new paragraph beginning with the words Our environmentally....

Change the margins to two inches top and bottom and 1.75" right and left.
Lesson 8
Graphics

Microsoft Works allows you to include graphics in your documents.  There
are a number of ways to insert the graphics into the document.

Method1
Using Draw On.

Select Edit Draw On.
A toolbox appears at the side of the screen.
Select the box tool.



12 © Ray O'Neill  and MIE 1991 revised 1993

Draw a large box n the screen.

When text is highlighted, it goes into reverse video, tht is instead of being
black on white it becomes white on black.  When a graphic is select it gets
handles at its edges.

Changing the line thickness.
With the graphic still selected.  Pick a thicker line thickness from those
displayed.

Resizing a graphic.
Select the graphic.
Click on the handle at the corner.
Drag the handle upwards to make the graphic smaller or downwards to
make it bigger.

Filling the box with a pattern.
With the box selected.  Select FillPattern from the menu.  Select a light
coloured pattern from those available.
Select the text tool and type the following.

You are invited to a
Party
on
21st Jan
at
8.00pm
Bring a drink and a Friend.

Format the text appropriatly.

Save and print the document.
Method 2

Inserting graphics from the scrapbook.
The scrapbook is a Desk Accessory (DA) which allows you to store
pieces of text or graphics and paste them into other applications.
Select the Apple menu.
Select Scrapbook. The scrapbook appears in a window.  A graphic or
piece of text is in the scrapbook.
Click along the Scrapbook scrool bar to see other graphics.  Pick one you
like then:
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Select Edit, Copy.  This places the chosen graphic on the Clipboard.
Close the Scrapbook by clicking the Close box.
Select Edit, Paste.  The graphic is inserted into your document.

Exercise:
Resize the graphic.

Method 3
Cut and Paste.

Open any other graphics application. for example MacPaint, MacDraw,
Superpaint 2, Claris CAD.
Open a picture file, or draw one yourself.
Select part of the picture and copy it to the clipboard.
Close the application.
Open MS Works.
Paste the picture into your document.

Exercise:
In the following exercises make use of as many features of Word as you
can.
Using the graphic Trekkie, which is on disk, design a letterhead for the Star
Trek Fan Club.
Using any graphic, design a letterhead of your own.


